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Introduction

Overview
A complete description of the
CAMARC formats is supplied
with the MLSviewer which
allows a user to view and edit
GCD and DST formatted files

This is an application that has been developed by Motion Lab Systems to allow users
to extract ASCII data from any number of files that use the CAMARC DST
specification to store information.  It is intended to provide an easy way for
statistitians and researchers to create ASCII files containing information extracted
from GCD files for submission to any statistics program for analysis.

The program allows you to select a large number of GCD files that are assumed to
contain gait data.  You can then select a single GCD file, display the contents, and
select a single multivalue variable (such as KneeFlexionExtension) and any number
of single value variables.  GCDexport will then create a single ASCII text file that
contains the data formatted in columns for easy access and analysis.

Figure 1: GCD Export User Interface
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Installation
GCDexport is supplied with the MLSviewer installation software.  You can use the
Windows Add/Remove Programs option in Control Panel to install GCDExport from
a floppy disk or CDROM.  If you download a copy from our ftp site on the Internet
(ftp.emgsrus.com), then just run the installation file.  This will install the program on
your system together with some example files that you can use to demonstrate and
play with the program.

If you accept the default options during installation, then you will have created a
short-cut in the Gait Lab menu group called MLS – GCDExport together with a
desktop short-cut.

GCDExport shows the name of the registered user in the About dialog box accessed
from the help drop-down menu.  This can be opened by choosing the About
command (Help menu.  This dialog box will also show you the Version Number of
the program.
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Using the Program

The User Interface
When the Motion Lab Systems GCDExport program is started the application
window will appear - this window will have a list with no items in it.  The window
will also have a menu bar, tool bar and status bar.  The program (like all MLS
programs) is a 32-bit Windows 95/NT application and will respond to all the normal
commands to position and control the display.  It can be represented on the screen in
one of the three ways: full screen (maximized), as an application icon (minimized),
or within a window (restored).  The application remembers the state in which it was
when it was last used and the size of the main window and the position of the
Toolbar will be the same.

The name of the directory from where the GCD files have been read will be
displayed in the top left corner of the application (before the name of the
Application).

At this point virtually all the commands that you will need are on the short-cut bar at
the top of the program window.

File Menu
The File Menu can always be selected from the left side of the Menu Bar.  This
menu contains commands that allow you to select the directory and extract the data.

Select Directory
This command can be used to select the directory that contains the files from which
the data needs to be extracted.  The opens a Select Folder dialog where you can
select the directory.
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Figure 2: Browse for Folder dialog

The application looks through the selected directory and uses all the files that have
an extension that you are looking for.  The extensions you want to use can be
specified by using the Options command on the View menu.

Export command
This command can be used to export the data from the selected data files to an
ASCII file.  This command opens the Export dialog box, where you can choose the
multi value variable and the single value variable(s) should need to be used.  The
application will then prompt you for an output file to which the data should be saved.

Once this choice is made, the application will extract the necessary data from each
data file and write to the output file.  The multi value variable will be written first for
each data file, followed by the percent of gait cycle, the side which the multi value
variable belongs to and then the columns of single value data.

The multi value variable in written to the file as it is found in the GCD file.  If there
are multiple columns of data in the GCD file, each column is written to the GCD file.

The percent of the gait cycle at which the data is collected is written.  You can
choose whether this should be written as an integer value or as a real value from the
Export Options dialog using the Options command (View menu).  If there are more
than 101 points in the cycle, the % gait cycle values should be written as real values.

There is a column titled legid which shows you the side which the multi value
variable belongs to, 0 for left side, 1 for right side and 2 for no associated side.

After the data is exported, the results of the export can be seen in the Log column of
the main view.  If a file is exported, this column will be empty.  If the data from the
file could not be exported, this column will specify the reason for it.

Export dialog box
This dialog box is used to select the single valued variable(s) and the multi value
variables that will be exported.
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This dialog box has the following controls:

Data Files
This is a drop list box that contains all the select data files.  When you select a file
from the list, the variable boxes below will be populated with the variables from the
selected file.

Side
This can be used to control the variables that appear in the boxes below.  Choosing
Left or Right will show variables from that side and also variables that have no side
associated with it.  Choosing Both will display all the variables.

Multi Valued Variables
This list box contains the multi valued variables from each data file.  These are
variables that have more than one data element.  You must choose one variable from
this box that will be exported.

Single Valued Variables
This list box contains the single valued variables from each data file.  These are
variables that have only one data element.  You can choose one or more variable
from this list by checking the box next to the variable name.

OK
This validates you choices and presents you will a Save As dialog box to choose an
output file.  If you choose the Cancel button in that box, you will come back to this
dialog box.

Cancel
This will close the dialog box and no data will be exported.

Exit
This command causes the GCDExport application to exit.
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View menu
This menu has items that can be used to control the appearance of the application and
also to set the options.

Toolbar
This command can be used to display and hide the Toolbar, which includes buttons
for some of the most common commands in GCDExport, such as  Select Directory.
A check mark appears next to the menu item when the Toolbar is displayed.

The toolbar is displayed across the top of the application window, below the menu
bar.  The toolbar provides quick mouse access to many tools used in GCDExport.

Select Directory command (File menu)

Export command (File menu)

About command (Help menu)

SHIFT + F1

Status Bar
This command can be used to display and hide the Status Bar, which describes the
action to be executed by the selected menu item or depressed toolbar button, and a
progress meter. A check mark appears next to the menu item when the Status Bar is
displayed at the bottom of the GCDExport window.

The left area of the status bar describes actions of menu items as you use the arrow
keys to navigate through menus.  This area similarly shows messages that describe
the actions of toolbar buttons as you depress them, before releasing them.  If after
viewing the description of the toolbar button command you wish not to execute the
command, then release the mouse button while the pointer is off the toolbar button.

Clear Log
This command can be used to clear all the entries in the Log column of the main
view.  The entries get cleared automatically when an export is started.

Options
This command can be used to set the options in the application.  It opens the Options
dialog box, where there are pages in which you can set the options.

Options dialog box
This is a dialog box that has two pages where you can choose the extensions that the
application should look for when searching a directory for data files and also set
some export options.
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Extensions page

Figure 3: Extensions Page

This page has the following controls:

Used Extensions
This list box shows you all the extensions that will be searched for.

New Extension
Enter the extension that you want to add to the list and click on the Add button.

Delete
This button can be used to delete the selected extension from the list.

Export Page

Figure 4: Export Page

This page has the following controls:
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Export Gait Cycle Data as
This allows you to choose the format in which the percent gait cycle field should be
written to the export file.

Help menu
This menu contains commands useful in finding for the Application.

Help Topics
This command gives an index of the help topics that are available for the application.
It is possible to search for a topic of interest.  Help is available by highlighting a
menu item and then clicking the F1 key.  Help can also be sought by clicking the
Shift-F1 keys.  This transforms the cursor into a help cursor and the user can click on
the item of interest to see the help topic associated with it.

MLS Home Page
If you have an Internet connection and use the World Wide Web then you can launch
your Internet Web browser directly from this item and visit the Motion Lab Systems
Home Page.  You can check here for new updates to this application as well as
download evaluation copies of other Motion Lab Systems software products.  You
can also contact Technical Support directly from this Web Page.

About GCDExport
This opens a dialog box provides information about the application.

This dialog box shows you the following information:

•  The Name of the Application with the Application Icon.

•  The Version Number of the Application.

General Information
This section lists some general information about the Application.

Title Bar
The title bar is located along the top of a window.  It contains the name of the
application and document.

To move the window, drag the title bar.  Note: You can also move dialog boxes by
dragging their title bars.

A title bar may contain the following elements:

•  Application Control-menu button

•  Maximize button

•  Minimize button
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•  Name of the application

•  Name of the document

•  Restore button

Scroll Bars
Displayed at the right and bottom edges of the document window, if the size of the
window is smaller than what it should be to display the contents of the window.  The
scroll boxes inside the scroll bars indicate your vertical and horizontal location in the
document.  You can use the mouse to scroll to other parts of the document.

Size command (System menu)

This command can be used to display a four-headed arrow so you can size the active
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to
move the pointer to the border you want to move.

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.

Move command (System menu)

This command can be used to display a four-headed arrow so you can move the
active window or dialog box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut

Keys: CTRL+F7

Minimize command (System menu)
This command can be used to reduce the GCDExport window to an icon.

Shortcut

Mouse: Click the minimize icon on the title bar.

Keys: ALT+F9
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Maximize command (System menu)
This command can be used to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.

Keys: CTRL+F10 enlarges a document window.

Close command (System menu)
This command can be used to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:  If you have multiple windows open for a single file, the Close command on
the file Control menu closes only one window at a time.  You can close all windows
at once with the Close command on the File menu.

Shortcuts

Keys: CTRL+F4 closes a file window

ALT+F4 closes the GCDExport window or dialog box

Restore command (System menu)
This command can be used to return the active window to its size and position before
you chose the Maximize or Minimize command.
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File Formats

Overview
The GCDexporter reads any number of GCD files from a single directory and allows
the user to select a vector variables and a number of scalar variables that are present
in the input GCD files.  These variables are then exported to a single ASCII file in a
TAB delimited format that is designed to be easy to access from any statistics or
spreadsheet program.

Input Files
The input file format is a DST lexicon that comprises a set of text and numeric
variables for use in the storage and/or transmission of processed gait analysis data.

The underlying characteristic of all time-sampled data contained in a GCD file is that
the sample timebase is normalized to the duration of one gait cycle, starting with
Initial Contact and ending with the subsequent Initial Contact. This provides the
great advantage that values on the same timebase sample can be compared and/or
averaged between different GCD files for different experiments. The cycle duration,
or StrideTime, is always included, allowing the timebase to be de-normalized.

The number of timebase samples included in one gait cycle is not fixed and may
change from one variable to another. For example, raw EMG generally requires
higher temporal resolution than joint angles. A default for the number of samples is
defined for each variable.

Where bilateral data is included in a GCD file, it will normally, but not necessarily,
correspond to the gait cycles for a pair of overlapping strides, normalized separately.
A typical GCD file looks like this:

#!DST-1.0 GCD Motion Lab Systems
$COMMENTS
!Cadence
0.995 0.098
!StrideTime
0.994 0.084
!PelvicTilt
10.355 3.772
10.215 3.745
10.049 3.718
. . .
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All variables defined a GCD file should conform to the CAMARC DST Syntax
Protocol and CAMARC Standard Terms and Definitions.

Output Files
The GCDexporter generates a single ASCII text file after reading the GCD input
files.  This file consists of header line, followed by a line for each vector sample in
the input GCD files.  Each line contains the vector sample, the gait cycle sample
percentage and a side identifier plus any selected variables.

PelvicTilt  %GC  legid  LeftCadence  LeftStrideTime
10.627 0    0      0.923 1.083
10.525 2    0 0.923 1.083
10.394 4    0 0.923 1.083
10.219 6    0 0.923 1.083
10.038 8    0 0.923 1.083
9.962 10   0 0.923 1.083
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Index

A
About dialog box 6

C
close 8

E
exit 3
export 2
export dialog box 2

F
file menu 1

H
Help menu 6
help topics 6

I
installation 2

L
log

clear 4

M
maximize 8
menu

file 1
Help 6
view 4

minimize 7
MLS Home Page 6

move 7

O
options 4
Options

Export 5
Extensions 5

Options dialog box 4

R
restore 8

S
scroll bars 7
select directory 1
size 7
status bar 4

T
title bar 6
toolbar 4

U
user interface 1

V
View menu 4


	Introduction
	Overview
	Installation

	Using the Program
	The User Interface
	File Menu
	Select Directory
	Export command
	Export dialog box
	Exit

	View menu
	Toolbar
	Status Bar
	Clear Log
	Options
	Options dialog box
	Extensions page
	Export Page


	Help menu
	Help Topics
	MLS Home Page
	About GCDExport

	General Information
	Title Bar
	Scroll Bars
	Size command (System menu)
	Move command (System menu)
	Minimize command (System menu)
	Maximize command (System menu)
	Close command (System menu)
	Restore command (System menu)


	File Formats
	Overview
	Input Files
	Output Files


	Index

